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中文摘要 

 
本研究建立以二甲基乙二肟（DMG）沉澱法進行海水中鎳-63（63Ni）之化學分離與液態閃爍計數

（LSC）分析流程。以 1 L海水為基質，透過酸化、濃縮、氨配位穩定化及 Ni(DMG)2沉澱分離，有效

達成鎳之選擇性分離。經優化後之三重複試驗顯示化學回收率為 88.6±2.0%，具良好再現性。干擾元素

去除能力評估結果顯示，多數元素（Co、Mn、Pb、Re、Ru、Sb、Sr）之去污因子（DF）皆大於 103，

Fe亦大於 102，顯示良好選擇性。LSC淬息曲線建立後，偵測效率約為 45–73%，最小可測量活度（MDA）

為 0.0311 Bq/L，符合環境樣品分析需求。與傳統鎳樹脂法相比，DMG法具成本低、操作簡便等優勢，

且於高鹽基質中仍可維持穩定回收率。結果顯示本方法具應用於環境水樣及低放射性廢水中 63Ni分析

之潛力，並可作為未來方法優化與應用發展之基礎。 

 

關鍵詞：鎳-63；液態閃爍計數儀；放射性廢棄物；環境輻射監測；海水；二甲基乙二肟 
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英文摘要 

 

This study developed a dimethylglyoxime (DMG)-based precipitation method for the chemical 

separation and liquid scintillation counting (LSC) analysis of nickel-63 (63Ni) in seawater. Using 1 L seawater 

samples, the procedure involved acidification, preconcentration, ammonia complexation, and selective 

precipitation of Ni(DMG)2 to achieve efficient nickel isolation. After optimization, triplicate experiments 

yielded a stable chemical recovery of 88.6 ± 2.0%, demonstrating good reproducibility. Decontamination 

factor (DF) evaluation indicated effective removal of interfering elements, with most elements (Co, Mn, Pb, 

Re, Ru, Sb, Sr) exhibiting DF values >103 and Fe >102. The LSC quench curve showed a detection efficiency 

of approximately 45–73%, and the minimum detectable activity (MDA) was determined to be 0.0311 Bq/L, 

meeting typical environmental monitoring requirements. Compared to conventional nickel-resin methods, the 

DMG approach offers advantages in cost-effectiveness and operational simplicity while maintaining reliable 

recovery in high-salinity matrices. Although 63Ni was not detected in the seawater samples due to ultra-trace 

levels, the developed method provides a robust analytical framework for environmental and low-level 

radioactive waste applications. This study demonstrates the feasibility of the DMG method for 63Ni analysis 

and provides a practical basis for further methodological refinement and future applications in radiochemical 

environmental monitoring. 

 

Keywords: 63Ni; liquid scintillation counter; radwaste; environmental radiation monitoring; seawater; 

Dimethylgloxime 
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1. 研究計畫之背景及目的 

1.1.研究背景簡介 

鎳-63（63Ni）為核能電廠中以中子活化方式產生之長半衰期（T1/2 = 100.1 年）純貝他釋放（Eβmax 

= 67 keV; Eβavg = 17 keV）之難測核種（difficult-to-measure radionuclide; DTM），其衰變之子核種為銅-63

（63Cu）（式 1），主要又以 62Ni(n, γ)63Ni 及 63Cu(n, p)63Ni 等核反應生成[1–2]。鎳金屬主要存在於原子

反應爐爐心及核燃料棒裝填之鋼材結構材料中。此外，鎳元素也存在於冷凝系統、水泥、鉛屏蔽、及

鋁合金當中[3]。其中，鎳元素在不同合金材料中所佔的比例常見如下：鎳基合金（50% – 75%）、不銹

鋼（10% – 20%）、鋯合金（~40%）及核燃料（~20%）[4]。鎳為一種銀白色金屬，擁有金屬性質特性。

它有高的電傳導及熱傳導特性，可容易進行拉伸、捲曲、鍛造及拋光等，其常見的物理化學特性如表

1 所示[5]。當核能電廠運轉年限越久時，所累積的鎳-63 放射性核種強度也將隨之增加。雖然鎳-63 釋

出的能量並不是相當高，但大量的鎳-63 將成為具風險的放射性危害物，表 2 彙整一些重要放射性核

種之放射危害程度比較。一般來說，當電廠運轉超過 30 年以上而需進行除役折解時，鎳-63 將是造成

工作人員輻射曝露的主要來源之一[6]。雖然鎳-63 非為放射性廢棄物分類處置及屏蔽之主要考量對象，

但它是活化核種中的主要部份，將也可能對環境及低階放射性廢棄物分類時造成重要影響。表 3 列出

鎳-63 貝他粒子平均能量（17 keV）於不同材料之射程。表 4 則彙整一些重要核種其最大貝他能量與

平均貝他能量之對照；其中，鎳-63 之貝他能量相對而言並不算太高，無法有效穿透人體的皮膚層（0.07 

mm），其對人體主要的風險為未受屏蔽保護的眼睛。由於鎳-63屬於一難測核種，它對環境、生物圈、

及放射性廢棄物的分類與處置等皆會造成一定程度影響；因此，建立鎳-63 難測核種的放射化學分析

及量測方法有其必要性。 

 

Ni63

100 y
→    Cu + β−63  (67 keVmax energy) ……................................................................................（式 1） 

 

我國放射性廢棄物的處置原則[7]主要參照美國核管會（US NRC）所訂定之放射性廢棄處置條例 10 CFR 

Part 61.55[8]，放射性廢棄物在處置前，必須先經過分類。低階放射性廢棄物主要可分為四類，包括：

A類、B 類、C 類及超 C 類。放射性廢棄物的分類主要依據其核種濃度、核種半衰期、及廢棄物的型

式等。表 5及表 6列出了放射性廢棄物分類時其難測核種之濃度限值依據[8]。放射性核種的量測，一

般可為分為易測核種及難測核種兩種。難測核種的分析，通常需要在放射性量測（radiometric）或質譜

儀（mass spectrometric）量測前進行化學分離及純化過程；舉例，像是純貝他衰變核種、阿伐衰變核種、

及釋放能量易受干擾之核種等[9]。由於難測核種的分析成本高及分析耗時等，比例因素（scaling factor; 

SF）成為一種替代直接量測的核種活度評估方式。比例因素的表示，主要以兩個不同參考核種之活度

比值得到，其中一個為主要欲量測之靶核種（targeted nuclide）活度，另一核種為關鍵核種（key nuclide）

活度[9–10]。其中，常用的關鍵核種包括有鈷-60（60Co，代表所謂活化核種）及銫-137（137Cs，代表所

謂核分裂核種），此兩者核種的特點為皆可釋放出易於計測的加馬輻射能量。 

表 7為文獻上以液態閃爍計數儀（liquid scintillation counter; LSC）方法進行鎳-63分析之彙整[9–10]。

目前，文獻中最常使用的鎳-63萃取方法為 Ni-DMG（Ni-dimethylgloxime; C8H16N4NiO4）萃取法。此方

法主要透過 Ni-DMG錯合物沉澱進而滯留於鎳樹脂管柱中，接著再以溶劑萃取法將其鎳收集，最後再

以 LSC進行鎳-63的活度量測[11–14]。LSC為鎳-63分析最常使用之工具，不僅是擁有高的計數效率（大

約 70%），其簡單與容易獲得亦是主因之一。目前，LSC已廣泛應用於環境輻射監測及放射性廢棄物分

析等。鎳-63的化學分離，已有市售之鎳樹脂（Eichrom Technologies）可供使用來進行水試樣中鎳的分

離。然而，原子爐中產生常見的活化核種（例如：鈷-60），可能與鎳共同滯留於鎳樹脂管柱中，成為

干擾核種，影響鎳-63分析的不準確性[15–19]。目前，顯少文獻資料及研究報告針對鎳-63分離時之干

擾元素移除能力進行探究。本研究中，將發展 Ni-DMG 沉澱法進行鎳-63 難測核種分析方法建立，並

嘗試以低背景 LSC進行鎳-63活度分析，期能改善鎳-63之分析準確度。另外，實驗中亦將探討不同干
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擾元素之移除能力，以及利用連續萃取技術方法等找出最佳化的鎳-63放射化學分離程序。本研究對鎳

-63難測核種分析方法之建立與完成，可望提供分析程序於環境輻射監測或核電廠中放射性廢棄物之鎳

-63分析，預期精進的方法可提升鎳-63的分析準確度、靈敏度、及最小可測量活度能力，以達到保障

民生輻射安全與降低放射性廢棄物之分類及處置成本。 

 

表 1：鎳的物理及化學特性[20–22]。 

物理特性（單位） 鎳的數據 

熔點（degree Kelvin） 1,726 

沸點（degree Kelvin） 3,005 

熔化熱（cal/g） 4,323 

汽化熱（cal/g） 90,800 

固體密度（g/cm3） 8.9 

氧化還原電位（V） 0.25 

游離電位（eV） 7,635 

晶體形式 face-centered-cubic 

 

表 2：一些重要放射性核種的放射危害程度比較[23]。 

放射毒性 核種 

非常高（Group 1） 
241Pu, 242Cm, 241Am, 237Np 

高（Group 2） 
60Co, 90Sr, 94Nb 

中（Group 3） 
14C, 63Ni, 137Cs 

低（Group 4） 
3H, 59Ni, 99mTc, 99Tc, 129I 

 

表 3：鎳-63貝他粒子平均能量（17 keV）於不同材料之射程評估[6]。 

材料介質 
17 keV貝他射線之評估最大射程

（mm） 

空氣 15.0 

水 0.02 

塑膠 0.014 

水泥 0.09 

鋁或玻璃 0.008 

鐵 0.0023 

鉛 0.0015 
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表 4：一些重要核種釋放貝他及鄂惹電子之平均及最大動能彙整[6]。 

核種 
䆁放電子能量 

平均能量（keV） 最大能量（keV） 

Nickel-59（59Ni） 4.1 ~7.7 

Tritium（3H） 5.7 19.0 

Nickel-63（63Ni） 17.1 67.0 

Iodine-129（129I） 40.0 150.0 

Carbon-14（14C） 49.0 156.0 

Technetium-99（99Tc） 85.0 293.0 

Iodine-131（131I） 180.0 806.0 

Cesium（137Cs） 195.0 1176.0 

Potassium-40（40K） 541.0 1330.0 

Phosphorus-32（32P） 694.0 1710.0 

 

表 5：單一長半衰期核種濃度值[8]。 

核種 濃度值 

14C 0.30 TBq/m3 

14C（活化金屬內） 3.0 TBq/m3 

59Ni（活化金屬內） 8.1 TBq/m3 

94Nb（活化金屬內） 0.0074 TBq/m3 

99Tc 0.11 TBq/m3 

129I 0.0030 TBq/m3 

TRU（半衰期大於 5年之超鈾阿伐放射核種） 3.7 TBq/g 

241Pu 130 TBq/g 

242Cm 740 kBq/g 
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表 6：單一短半衰期核種濃度值[8]。 

核種 
 濃度值（TBq/m-3） 

 第一行 第二行 第三行 

半衰期小於 5年之所有核種總和  26 註 註 
3H  1.5 註 註 
60Co  26 註 註 

63Ni  0.13 2.6 26 

63Ni(活化金屬內)  1.3 26 260 
90Sr  0.0015 5.6 260 
137Cs  0.037 1.6 170 

註（1）：B 類廢棄物及 C 類廢棄物並無此核種濃度值之限制。可從實際執行運送、吊卸與最終

處置作業時，考量體外輻射與衰變熱，而限制這些核種之濃度。除非由本表內其他核種決定廢

棄物歸於 C類廢棄物，否則應歸於 B類廢棄物。 

註（2）：多核種之分類時：若低放射性廢棄物中含有多核種時，其分類應案下式判斷。 


=


n

i i

i

C

C

1 x,

1  

式中 

Ci：第 i個核種之濃度 

Ci,x：第 i個核種第 X（X = A、B、C）類之濃度值 

N：所含核種之數目 

若滿足上式，則可歸為第 X（X = A、B、C）類廢棄物。 

 

表 7：以液態閃爍計數儀方法進行鎳-63核種分析之分離技術彙整[10]。 

樣品種類 
樣品重量 

（g） 

分離方

法* 

回收率

（%） 

最 低 可

偵測值 

（Bq/g） 

效率 

（%） 
量測活度（Bq/g） 

污泥、液體 0.25–5  H+D+A 68–94 0.037–

3.33 

― 2.18×102–2.35×104 

不銹鋼、銅 0.5–0.6 D+A 94 0.035 ― 0.69–3.7 

環境樣品 100 D+A 95 0.005 52 2.48 

石墨、水泥、鋁、鉛 0.5–1 H+D+A 90 0.014 70 – 72 2.28–603 

反應爐排放水 50 D+A 90 0.001 ― 0.002–243 

水泥 5–50 H+D+A 49–71 0.002–

0.016 

38 – 49 0.041–3.24 

樹脂、過濾膜 ― H+F+D 58 0.012 72 31–1.48×104 

放射性廢液 1 D 92–95 0.038–

0.040 

71 0.25–2.86 

註：*分析方法表示，H：氫氧化物沉澱；D：DMG萃取; A：陰離子交換管柱；F：薄膜過濾。 

 

1.2.研究重要性與目標 

1.2.1. 鎳-63對環境及低放射性廢棄物之輻射安全重要性 
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鎳-63核種核種屬於一人工放射性核種，主要透過原子爐中的中子活化反應生成，為低階放射性廢

棄物中活度的主要貢獻核種之一。我國三座核電廠（核一、核二及核三廠）共 6 部機組均已服役超過

30 年以上，其所產生的鎳-63 活度將會是為除役拆廠及環境輻射監測之重要標的核種。放射性廢棄物

的處理過程中，少量或部份的鎳-63可能從反應爐（例如：不銹鋼表面的腐蝕及循環水系統等）進入環

境當中，造成環境及人員危害可能[6]。鎳的化學氧化態常以 Ni2+的形式存在，其對水及空氣有一定程

度之抗性，因此常用來做為金屬或合金之塗層材料，提供抗腐蝕應用（例如：不銹鋼材）。在環境中，

土壤能吸附來自地下水源中的大部份的鎳-63，一般認為與土壤的形態及水源中的 pH 值有直接關聯；

據調查，比例上有 1%或小於 1%的鎳可能滯留於地下水源中[24]。然而，水源中是否存在鎳螯合劑（像

是 EDTA及 DTPA）將是影響鎳遷徙的重要因子。植物及動物可能攝取土壤中的鎳-63進而進入人類的

食物鏈中，而鎳-63於人體的生物半衰期約為 500–1,200天，被歸類在中等危害程度之放射性核種。已

有一些研究對鎳-63進入人體所造成的體人輻射劑量進行評估，若透過吸入鎳-63所對體內器官之曝露，

在一天的曝露時間，其可對體內器官（包括：肺、性腺、骨髓、及甲狀腺等）造成的輻射劑量約在~8×10-10 

Sv/Bq；此外，若透過攝入鎳-63所造成之曝露，其輻射劑量約在~8×10-11 Sv/Bq [25]。 

 

1.2.2. 難測核種對低階放射性發棄物之分類依據 

我國核安會參照美國核管會 10 CFR61（NRC, 1982）條例[7–8]訂定「低放射性廢棄物最終處置及

其設施安全管理規則」，並列出一些關鍵性放射性核種，鎳-63核種為其中之一。表 5及表 6中所訂定

的關鍵放射性核種大多屬於難測核種，並根據此些核種的特性、半衰期與濃度將低放射性廢棄物進行

分類為 A、B、C與超 C類，其分類原則敘述如下。因此，鎳-63核種的分析方法建立對於低階放射性

廢棄物的分類具有相當重要之影響；同時，也對未來在進行放射性廢棄物處置及長期貯存時，提供輻

射安全與防護工程設計上之重要參考。 

(1). Ａ類廢棄物：指低放射性廢棄物所含核種濃度低於(含)表 5濃度值之十分之一倍及低於(含)表 6第

一行之濃度值者；或廢棄物所含核種均未列入表 5及表 6者。 

(2). Ｂ類廢棄物：指低放射性廢棄物所含核種濃度高於表 6第一行之濃度值且低於(含)第二行之濃度值

者。 

(3). Ｃ類廢棄物：指低放射性廢棄物所含核種濃度高於表 5濃度值十分之一倍且低於(含)表 5之濃度值

者；或高於表 6第二行之濃度值且低於(含)第三行之濃度值者。 

(4). 超Ｃ類廢棄物：指低放射性廢棄物所含核種濃度高於表 5 之濃度值者；或高於表 6 第三行之濃度

值者。 

 

1.2.3. 鎳-63對環境土壤、地下水、植物及空氣中的重要性 

瞭解放射性核種鎳-63之特性非常重要，因其可能散佈或轉移至生物圈，進而對民眾造成可能之危

害。事實上，穩定鎳元素為自然分佈於環境土壤中，其自然環境中土壤中的鎳濃度分佈為 5 – 1,000 ppm

（至高可達 6,200 ppm），比放射性廢棄物中的鎳-63還高出許多。鎳也存在於地下水源中，其濃度約在

50 ppm左右[26]。當水源的酸鹼值在 pH8以下時，主要的鎳離子型式為 Ni2+。為評估環境中遭受來自

污染水源或灌溉水之土壤中鎳污染可能，四項依次重要的評估參數包括有：（1）土壤滯留；（2）年度

沉澱率；（3）土壤質地；（4）土壤至距地下水位距離等[27]。由於鎳的特性傾向吸附於土壤，當鎳進入

土壤系統時，超過 90%的鎳將快速與土壤結合，因此從地下水中移除，造成環境土壤污染。然而，幾

種重要因子可能改變其行為，（例如：水源中的 pH值及螯合劑的存在），將使鎳從地下水源中移除變得

緩慢。研究調查曾觀察到地下水源中含有數種放射性核物種存在，其中包括鎳-63，以非離子態的化學

形式存在，推測可能與有機污染物形成錯合物的型式存在[28–29]。 

有關鎳在植物中累積的調查與紀錄[30]，幾乎大部份是來自天然穩定的鎳元素；然而，鎳-63的分
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佈行為應可依循穩定鎳元素之分佈情況作為輻射安全防護基礎。鎳可藉由植物的根、莖、葉等吸收途

徑進入植物，大部份的植物中，鎳從土壤進入植物的百分比大約為 10%；然而，在一些豆科植物中則

可能高達至 50%。但目前無數據顯示它會累積在種仔及水果等植物中。此外，有調查研究顯示一些海

洋植物可能累積鎳之濃度超過水中的 1000倍以上。因此，鎳透過海洋植物給吸收，而此些植物再進入

人類或動物生物圈之攝取，是可能需留意的曝露途徑。 

鎳同位素正常情況下並不會於大氣中存在，除了非常少見可能由熱核炸彈試驗中所釋放於大氣層

中。放射性的鎳-63幾乎全由反應爐的中子活化反應產生，其並不會出現在核分裂產物中。因此，即使

原子爐遭受壞損，部份核分裂產物同位素外洩，但鎳-63直接造成外釋至大氣的可能性仍相當低。目前

僅相當少數的鎳-63環境污染偵測紀錄，包括在一些土壤及海洋生物中，其最大的濃度僅在萬億分之一

（ppt）範圍。雖然正常環境中存在鎳-63的濃度相當低，但它的長半衰期仍可能帶來環境中的影響。 

 

1.2.4. 鎳-63分析技術的重要性 

放射性廢棄物中的核種分析，一般可分為易測核種及難測核種兩種。易測核種係指如 60Co與 137Cs

等加馬釋放核種，其釋放的加馬能射線可容易被直接偵測。所謂「難測核種（DTM）」則通常定義在放

射性量測或質譜儀分析前，需要經過化學分離程序或純化以移除可能的干擾核種，避免在量測靶核種

時所產生干擾，影響分析準確度。然而，難測核種的分析需要耗費相當大的時間與成本，無法大批量

進行分析。因此，一種替代評估難測核種活度之方式稱為「比例因數（SF）」，此種方法是靠料源的抽

樣性的分析，並建立系統性的比例因素資料庫，僅需透過簡單的核種濃度比對就可評估該料源當中的

難測核種活度，簡化了評估廢料中難測核種的程序。例如：63Ni/60Co 比例因數。美國核能管制委員會

（NRC）規範了一些難測核種的偵測低限建議值[31]如表 8 所列，以使放射性廢棄物之分類能符合規

定。 

 

表 8：美國核管會對低放射性廢棄物核種分析低限建議值 [31] 

放射核種 可達到的偵測範圍（Ci/m3） NRC建議的偵測值（Ci/m3） 
3H 
14C 
55Fe 

Gamma-Ray Emitting 

Corrosion Products 
59Ni 
63Ni 
90Sr 
94Nb 
99Tc 
129I 
137Cs 
144Ce 
235U 
238U 

Alpha Emitting 

Transuranics 
241Pu 

0.2-3×10-6 

0.5-8×10-6 

1×10-3-3×10-6 

0.5-1×10-6 

 

0.1-2×10-5 

0.05-7×10-6 

0.02-1×10-6 

0.04-3×10-7 

0.01-8×10-7 

0.02-3×10-7 

0.5-1×10-6 

4-2×10-7 

4×10-3-4×10-7 

2×10-3-8×10-8 

2×10-6-4×10-8 

 

2×10-3-3×10-6 

0.4 

0.08 

7 

7 

 

2.2 

0.035 

4×10-4 

0.002 

0.03 

8×10-5 

0.01 

7 

― 

― 

0.001 

 

0.035 

 

1.2.5. 鎳-63分析技術的研發目的 

為原子爐中透過中子活化所產生的難測核種[32]，其100年的長半衰期可能對環境及低階放射性廢

棄物分類及處置時造成重要影響，亦可能造成環境之影響可能。目前，常用的LSC於鎳-63分析時，常

發生干擾核種存在而影響LSC的分析準確度問題。因此，本研究旨在開發鎳-63難測核種分析方法建立，
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並主要針對海水試樣進行鎳-63分析；同時，實驗將探討移除干擾核種之效率[10] [33]。此研究之完成，

能直接提供政府機關構及相關學研單位參考，提供在環境輻射監測及低階放射性廢棄物中水試樣中的

鎳-63之分析程序及量測方法，用以保障民生輻射安全及放射性廢棄物分類與處置之核能安全。 

 

2. 研究方法與步驟 

2.1.研究方法簡介與規劃 

本研究主要發展以丁二酮肟（Dimethylgloxime; DMG）化合物作為環境及低放射性廢棄物水試樣

中鎳-63之共沉分離程序建立（圖 1），並利用低背景液態閃爍計數儀（LSC）進行鎳-63之放射活度分

析。當鎳會與丁二酮肟進行反應錯合時，將形成紫紅色的「鎳-丁二酮肟錯合物（[Ni(C2H4N)4](CNS)2; 

dipyridine nickel dithiocyanate; Ni-DMG）」而沉澱，之後可再以適當濾紙進行將沉澱的鎳-丁二酮肟錯合

物（[Ni(C2H4N)4](CNS)2; dipyridine nickel dithiocyanate; Ni-DMG）」與其它元素或核種進行化學分離及

分別收集。同時，本研究亦將探討鎳-丁二酮肟錯合物在分離時，達到改善干擾核種移除能力。經分離

之試樣，放射性鎳-63 以液體閃爍計數儀（LSC）」計測，穩定元素如鈷（Co）、錳（Mn）、鉛（Pb）、

鐵（Fe）、錸（Re）、釕（Ru）、銻（Sb）、鍶（Sr）等則以感應耦電荷原子發射光譜分析儀（ICP-AES）

進行分析。 

 

 

圖 1：鎳與 DMG（Dimethylgloxime）化合物形成 Ni-DMG錯合物（Ni-DMG complex (Ni(DMG)2)）示

意圖。（A）DMG化合物；（B）Ni-DMG錯合物。 

 

2.2. 儀器設備 

液體閃爍計數儀（Perkin-ElmerTM Tri-Carb® 2910 LSC或 Hidex 300SL Super Low Level automatic 

TDCR liquid scintillation counter）、HPGe加馬能譜分析儀（GC3020, Canberra Meriden, Connecticut, USA）、

感應耦合電漿-原子放射光譜（ICP-AES; Inductively Coupled Plasma with Atomic Emission Spectroscopy）、

烘箱、超音波振盪器、化學抽氣櫃、數位型加熱攪拌器、酸鹼測定儀、Acrylic Column Rack、計時器、

微量吸管套組、微量天秤、血清瓶（500 毫升、1000毫升）、閃爍計數瓶（20毫升）、燒杯、玻璃品皿

一批、樣品試管架（30毫米 x 30毫米）。 

 

2.3.藥品試劑 

Nickel-63 standard solution (NIST SRM 4226C) (Gaithersburg, MD 20899, USA), mixed gamma 

standard source with a geometric filter for efficiency correction of the gamma spectrum (Eckert & Ziegler Inc., 

Atlanta, GA30318, USA), cocktail of Ultima Gold LLT (PerkinElmerTM, MA 02451, USA), nitromethane 

(SigmaAldrich, MO, USA), chloroform (SigmaAldrich, MO, USA), Ni-resin (100–150 μm particle size resin) 

(Eichrom Technologies Inc, IL 60561, USA), varying ICP standard (AccuStandard Inc, CT 06513, USA), 
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Environmental Express Column w/ Frit, 5.5mL Bed Area Capacity, 250pk (Environmental Express Inc, SC 

29492, USA). Ni(NO3)2．6H2O（Nickel carrier; Nickel(II) nitrate hexahydrate; 99.999% trace metals basis; 

203874 Aldrich®）. (NH4)2C6H6O7（ammonium citrate dibasic; puriss. P.a., ACS reagent, > 99% (T); MW = 

226.18; 09831 Fluka®）.NH4OH（ammonium hydroxide solution, concentrated; ACS reagent, 28-30%; 

320145 Sigma-Aldrich® ） . HCl (hydrochloric acid, concentrated; ACS reagent, 37%; 258148 

Sigma-Aldrich®). HNO3（nitric acid, concentrated; ACS reagent, 70%; 438073 Sigma-Aldrich®） . 

Thymolblau, 0.1 mg/20% EtOH (831 L560976; C27H30O5S; pH 1.2-pH2.8 violettrot-gelb, pH 8.0-pH 9.6 

gelb-blau). All other chemicals and reagents used were of the analytical grade and obtained from 

Sigma-Aldrich® Inc. (MO, USA).  

 

2.4.鎳-63化學分離程序 

鎳-63水試樣中鎳-63分離程序實驗流程如下（圖 2）：首先，取水試樣 1 L海水樣品。接著，進行

初步過濾，使用玻璃纖維濾紙 GC-50（孔徑 0.5 μm、直徑 47 mm，ADVANTEC®）過濾海水，以去

除懸浮微粒。接著，進行樣品酸化，加入約 3.3 mL 濃鹽酸（HCl），將樣品溶液酸化至 pH 1.5，以避

免樣品儲存期間金屬離子沉澱。接著，再加入穩定同位素載體（Spike）：向樣品中加入 1 mL 含有 Ni、

Fe、Co、Mn、Sr、Ru、Pb、Sb、Re 之穩定金屬溶液（對應於 1 mg / 1 L 水樣）。接著，加熱濃縮，

將樣品溶液加熱濃縮至約 100 mL；設定加熱板溫度為 320 °C，並確認溶液實際溫度達到 90 °C。接

著，進行冷卻，將樣品溶液冷卻至室溫。接著，再次過濾，使用玻璃纖維濾紙 GC-50（孔徑 0.5 μm、

直徑 47 mm，ADVANTEC®）過濾，以去除加熱過程中生成之懸浮物。接著，中和與配位穩定化，加

入約 4.5 mL 氨水（NH₄OH），將溶液中和至 pH 9.0，使鎳以穩定的 [Ni(NH₃)₄]²⁺ 配位形式存在。接

著，加入 DMG試劑：加入 16 mL之 1%（w/v）二甲基乙二肟（DMG）溶於 50% 乙醇溶液。接著，

攪拌與沉澱生成：於室溫下攪拌 30 分鐘，確保鎳與 DMG 完全反應，形成粉紅色 Ni(DMG)₂ 沉澱。

接著，沉澱過濾分離：使用 1張玻璃纖維濾紙 GC-50（孔徑 0.45 μm、直徑 25 mm，ADVANTEC®）

過濾反應溶液，以分離 Ni(DMG)₂ 沉澱並去除其他雜質。接著，濾紙洗滌：以 100 mL之 0.2 M 檸檬

酸銨（ammonium citrate）溶液洗滌濾紙，以去除殘留雜質。接著，沉澱溶解：將捕集 Ni(DMG)₂ 沉澱

之濾紙置入 12 mL之 3 M 硝酸（HNO₃）中，在 20 mL 玻璃樣品瓶內溶解，使 Ni(DMG)₂ 轉為游離

態鎳。若需進行 ⁵⁹Ni 量測，則於溶解前，先以 LEPS 偵測濾紙中的 ⁵⁹Ni 活度，再將濾紙溶解於 3 M 

HNO₃ 中。最後，分析取樣：取 2 mL 樣品溶液進行穩定鎳濃度（ICP-OES）分析；另取 2 mL 進行 ⁶³Ni 

之液態閃爍計數（LSC）分析。 

 

 

圖 2：鎳-63化學分離與計測程序實驗流程圖。 
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2.5.計測與效率校正程序 

2.5.1. 計測程序 

首先，將欲使用 LSC進行試樣的絕對定量分析時（例如：得到 DPM結果）。首先，必須先完成建

立該核種之效率測定及消光曲線（Quench-Standard；請參照下節之三步驟完成）。接著，確認

Quench-Standard建立後，於QuantaSmart（TM）電腦畫面中，按以下路徑完成鎳-63試樣「Assay Protocol」

設定：File→New Assay→DPM（single） Type→Radionuclide Name中，建立試樣條件→按 Save As並

輸入 File Name（63Ni-Jimmy）。再確認此「Assay Protocol」連結上先前設定之 Quench-set。將滑鼠移動

到螢幕左邊欲使用的旗標號碼（例如：Flag 4），按下右鍵點選 Associate Assay→選擇要分析的 File Name

（例如：63Ni-Jimmy），點選後進行連結。完成上述「Assay Protocol」相關設定及連結後，依序放入待

測鎳-63試樣於卡夾中，並插入所連接的號碼旗標（例如：Flag 4），待樣品放置於機槽內平衡 1小時後，

按下綠色旗標開始進行鎳-63試樣計測。最後，待計測完後，分析報告由列表機列印輸出。 

 

2.5.2. 鎳-63標準射源 

使用可追溯國際或國家標之放射性核種鎳-63參考物質。 

 

2.5.3. 製備消光曲線樣品 

首先，取 10個 20毫升的閃爍計數瓶，並於瓶蓋編號 0至 9。將上述 10個計數瓶分別加入 1.9毫

升的硝酸（HNO3）。接著，分別加入 0.1毫升鎳-63射源。接續，分別再加入 18毫升 Ultima GoldTM LLT

閃爍液。最後，加入淬息劑（nitromethan）；除了第 0瓶外，從第 1瓶至第 9瓶依序加入淬息劑 10, 20, 

30, 40, 50, 60, 70, 80, 90微升（表 9）。小心密封旋緊上蓋後，輕輕搖勻並置於 LSC中 12小時，然後各

計數 30分鐘，建立消光曲線並儲存於儀器的電腦軟體中。 

 

表 9：鎳-63消光曲線標準品製作參數 

No 
Ni-63 standard 

(1,051 Bq/g) 

3M Nitric acid 

(HNO3) 

Ultima GoldTM 

LLT (cocktail) 

Nitromethan 

(quench 

agent) 

0 0.1 mL 1.8 mL 18 mL 0 μL 

1 0.1 mL 1.8 mL 18 mL 10 μL 

2 0.1 mL 1.8 mL 18 mL 20 μL 

3 0.1 mL 1.8 mL 18 mL 30 μL 

4 0.1 mL 1.8 mL 18 mL 40 μL 

5 0.1 mL 1.8 mL 18 mL 50 μL 

6 0.1 mL 1.8 mL 18 mL 60 μL 

7 0.1 mL 1.8 mL 18mL 70 μL 

8 0.1 mL 1.8 mL 18 mL 80 μL 

9 0.1 mL 1.8 mL 18 mL 90 μL 

註：計測效率（Eff）之選擇以編號「0」無添加任何淬息劑之組別為依據 
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2.5.4. 建立消光曲線操作程序 

建立 Quench-Standard 消光效應曲線時，在 QuantaSmart 電腦畫面中，按以下路徑完成鎳-63 消光

曲線設定：File→New Assay→Quench-Standard→輸入參數值及計測條件→Save As、並輸入儲存檔名 File 

Name（例如：63Ni-S）。接著，將滑鼠移動到螢幕左邊欲使用的旗標號碼（例如：Flag 1），按下右鍵點

選 Associate Assay→找到 Qucnch-Standard檔名（63Ni-S）點選後進行連結。完成上述 Quench-Standard

相關設定後，依序放入配製好之 Quench-Standard（10瓶）樣品於卡夾中，並插入所連接的號碼旗標（例

如：Flag 1），待樣品於機槽內平衡 1小時後，按下綠色旗標開始進行鎳-63消光曲線標準品計測。 

 

2.6.化學回收率、活度計算及儀器最小可測量活度計算 

2.6.1. 化學回收率 

在化學分離程序前試樣加入放射性鎳-63 標準品與經 Ni-DMG 鎳樹脂管柱分離並經由液態閃爍計

數儀測得鎳-63，其分離後鎳-63活度值與最初添加標準鎳-63活度值之比值即為化學回收率。 

 

化學回收率(%) =
經鎳管柱分離後鎳− 63活度值

最初添加之標準鎳− 63活度值
× 100% 

 

2.6.2.  試樣活度計算 

試樣活度計算如下： 

 

DPM = As − Ab =
Rs −Rb

Eff
     A(

Bq

L
) =

As −Ab
60

×
1

V
 

 

標準差（σ）計算如下： 

σ(cpm) = √
Rs

ts
+
Rb

tb
      

     

σ (
Bq

L
) =  

σ(cpm)

Eff × 60
×
1

V
 

 

上述各名詞定義如下：DPM：每分鐘衰變率、As：試樣衰變率（dpm）、Ab：背景衰變率（dpm）、Rs：

試樣計數率（cpm）、Rb：背景計數率（cpm）、Eff：計算效率、A：放射活度（Bq/L）、V：試樣體積（L）、

ts：試樣計測時間（min）、tb：背景計測時間（min）。 

 

2.6.3.  儀器最小可測量活度計算 

以液態閃爍計測儀計測鎳-63核種活度時，其儀器最小可測量活度（MDA）值計算如下： 

 

MDA =
4.65 × √B + 3

60 × E × R × V × T
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其單位為：活度／體積 或 活度／質量（Bq/L） 

 

式中各名詞定義如下，T：適當之空白試樣計數時間（分）、E：待測核種的計數效率、R：化學回收率、

V：試樣量，以體積或質量為單位表示、B：適當之空白試樣的計數值，適宜空白試樣含合適物質與雜

質（或干擾物質）；化學處理程序、計測方法、計測時間及幾何形狀均與待分析之試樣相同。 

B = Rb × tb 

 

2.7.重要儀器與設備 

2.7.1. 液態閃爍計數儀暨儀器偵測原理 

本研究主要使用新穎之低背景液態閃爍計數儀（Hidex 300SL Super Low Level automatic TDCR LSC）

作為鎳-63 分析儀器。低背景值液態閃爍計數儀較適合於環境樣品等較低貝他放射活度的量測與分析

（圖 3A）及傳統液態閃爍計數儀（Perkin-ElmerTM Tri-Carb® 2910 LSC）（圖 3B）。 

由於貝他射線之粒子射程較短，無法像光子輻射（X-ray或加馬輻射）可穿透物質，進入偵檢器進

行作用。因此，常見貝他釋放核種常以「液態閃爍計數儀（LSC）」進行貝他輻射計測。原理是將分離

純化後的貝他核種溶液與有機閃爍溶液（常稱 Cocktail）進行混合，此時核種所放出的貝他射線能透過

閃爍液中的溶劑分子將能量傳遞給閃爍分子，閃爍分子得到能量後會被激發至激發態，當其回到基態

時，將釋放出螢光，螢光可穿透塑膠瓶（或玻璃瓶）而到達光電倍增管（PMT）之光陰極，此時在光

陰極發生光電效應，並釋放出光電子，光電子再透過一連串的代納倍極放大，最終 PMT可將電子訊號

放大約 210至 410倍，接著形成可被偵測及分析的電流或脈衝訊號。此外，為了降低背景輻射之干擾，

LSC 使用之 PMT 設計，有傳統的 2 根或較新穎技術的 3 根 PMT 的設計，此些偵測系統採用耦合

（Coincidence）電路方式計測，已達到濾除雜訊，提升解析度等之應用。待偵測訊號經耦合電路確認

後，可再送放大器及類比數位轉換器，最後可得到該核種之貝他輻射能譜。 

 

 
圖 3：液態閃爍計數儀。圖（A）為 Hidex 300SL Super Low Level automatic TDCR LSC及圖（B）為

Perkin-ElmerTM Tri-Carb® 2910 LSC。 

 

3. 結果與討論 
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3.1.鎳-63化學分離程序 

Ni-DMG沉澱法進行鎳-63化學分離設備建置及分離操作程序示意圖（圖 4）。水試樣中鎳-63分離

程序實驗流程如下：首先，取水試樣 1 L海水樣品。接著，進行初步過濾，使用玻璃纖維濾紙 GC-50

（孔徑 0.5 μm、直徑 47 mm，ADVANTEC®）過濾海水，以去除懸浮微粒。接著，進行樣品酸化，

加入約 3.3 mL 濃鹽酸（HCl），將樣品溶液酸化至 pH 1.5，以避免樣品儲存期間金屬離子沉澱。接著，

再加入穩定同位素載體（Spike）：向樣品中加入 1 mL 含有 Ni、Fe、Co、Mn、Sr、Ru、Pb、Sb、Re 之

穩定金屬溶液（對應於 1 mg / 1 L 水樣）。接著，加熱濃縮，將樣品溶液加熱濃縮至約 100 mL；設定

加熱板溫度為 320 °C，並確認溶液實際溫度達到 90 °C。接著，進行冷卻，將樣品溶液冷卻至室溫。

接著，再次過濾，使用玻璃纖維濾紙 GC-50（孔徑 0.5 μm、直徑 47 mm，ADVANTEC®）過濾，以

去除加熱過程中生成之懸浮物。接著，中和與配位穩定化，加入約 4.5 mL 氨水（NH₄OH），將溶液中

和至 pH 9.0，使鎳以穩定的 [Ni(NH₃)₄]²⁺ 配位形式存在。接著，加入 DMG試劑：加入 16 mL之 1%

（w/v）二甲基乙二肟（DMG）溶於 50% 乙醇溶液。接著，攪拌與沉澱生成：於室溫下攪拌 30 分鐘，

確保鎳與 DMG 完全反應，形成粉紅色 Ni(DMG)₂ 沉澱。接著，沉澱過濾分離：使用 1張玻璃纖維濾

紙 GC-50（孔徑 0.45 μm、直徑 25 mm，ADVANTEC®）過濾反應溶液，以分離 Ni(DMG)₂ 沉澱並

去除其他雜質。接著，濾紙洗滌：以 100 mL之 0.2 M 檸檬酸銨（ammonium citrate）溶液洗滌濾紙，

以去除殘留雜質。接著，沉澱溶解：將捕集 Ni(DMG)₂ 沉澱之濾紙置入 12 mL之 3 M 硝酸（HNO₃）

中，在 20 mL 玻璃樣品瓶內溶解，使 Ni(DMG)₂ 轉為游離態鎳。若需進行 ⁵⁹Ni 量測，則於溶解前，

先以 LEPS 偵測濾紙中的 ⁵⁹Ni 活度，再將濾紙溶解於 3 M HNO₃ 中。最後，分析取樣：取 2 mL 樣

品溶液進行穩定鎳濃度（ICP-OES）分析；另取 2 mL 進行 ⁶³Ni 之液態閃爍計數（LSC）分析。 

 

 
圖 4：Ni-DMG沉澱法進行鎳-63化學分離設備建置及分離操作程序示意圖。 
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3.2.試樣計測程序： 

鎳-63 試樣以液態閃爍計測儀之計測程序如下：欲使用 LSA 進行試樣的絕對定量分析時（例如：

得到 DPM結果）。首先，必須先完成建立該核種之效率測定及消光曲線（Quench-Standard；請參照下

節之三步驟完成）。接著，確認 Quench-Standard 建立後，於 QuantaSmart（TM）電腦畫面中，按以下

路徑完成鎳-63試樣「Assay Protocol」設定：File→New Assay→DPM（single） Type→Radionuclide Name

中，建立試樣條件→按 Save As並輸入 File Name（63Ni-Jimmy）。接著，確認此「Assay Protocol」連

結上先前設定之 Quench-set。接著，將滑鼠移動到螢幕左邊欲使用的旗標號碼（例如：Flag 4），按下

右鍵點選 Associate Assay→選擇要分析的 File Name（例如：63Ni-Jimmy），點選後進行連結。接著，

完成上述「Assay Protocol」相關設定及連結後，依序放入待測鎳-63試樣於卡夾中，並插入所連接的號

碼旗標（例如：Flag 4），待樣品放置於機槽內平衡 1小時後，按下綠色旗標開始進行鎳-63試樣計測。

接著，計測完後，分析報告由列表機列印輸出。 

 

3.3.鎳-63分離之化學回收率評估 

表 10為彙整利用Ni-DMG法進行 1公升海水中鎳分離之回收率測試評估。由結果可得實驗編號 2、

4、5、6、7結果之最終化鎳-63化學回收率分別得到 89.5、107.6、99.6、105.2、115.4%，其數值較為

波動及有些超過 100%，可能為實驗中定量體積上的不準確性造成。在經過調整及優化後再重複一次三

重複實驗，可得較穩定的回收率值在 89.4、90.2、86.3%，其平均值回收率在 88.6±2.0%，顯示建立的

化學分離技術可達穩定之化學回收率在穩定接近 90%。 

 

表 10：鎳-63化學分離回收率評估彙整 

Trial 

(Name) 

CPM 

(Mean) 

CPM 

(SD) 

EFF 

(Mean) 

EFF 

(SD) 

DPM 

(Mean) 

DPM 

(SD) 

RY(%)- 
63Ni 

RY(%)-    

stable Ni 

#1 (blank) 27.0 1.7 0.64 0.03 42.2 4.2 ― ― 

#2 (spiked) 629.4 8.4 0.58 0.01 1090.8 11.1 87.4 89.47 

#3 (STD) 5293.1 13.1 0.73 0.00 7241.8 19.3 ― ― 

#4 (spiked) 522.7 13.5 0.43 0.01 1212.1 14.5 94.3 107.64 

#5 (spiked) 427.3 16.7 0.39 0.01 1097.1 10.9 87.4 99.55 

#6 (spiked) 348.3 14.8 0.31 0.01 1121.2 21.0 86.9 105.18 

#7 (spiked) 224.7 47.5 0.23 0.03 950.0 103.1 73.2 115.38 

#8 (STD) 5478.8 16.3 0.73 0.00 7488.1 22.1 ― ― 

 

3.4.化學回收率因子評估 

鎳-63化學分離時之干擾核種移除能力評估，其結果如表 11所示。其在三重複的試驗中，其探討

的鈷（Co）、錳（Mn）、鉛（Pb）、鐵（Fe）、錸（Re）、釕（Ru）、銻（Sb）、鍶（Sr）元素的移除能力，

除了鐵的移除能力 DF在大於 102外，其餘干擾元素之 DF皆能大於 103。顯示此鎳-63化學分離程序可

有效將常見放射分析的干擾元素移除至一定的微量以下，以防止鎳-63分析時之干擾。 
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表 11：干擾核種移除能力評估彙整 

Fraction 

Decontamination factors 

Co Mn Pb Fe Re Ru Sb Sr 

N=1 >103 >103 >103 >102 >103 >103 >103 >103 

N=2 >103 >103 >103 >102 >103 >103 >103 >103 

N=3 >103 >103 >103 >102 >103 >103 >103 >103 

註：DF = （初始添加的元素濃度 / 最終分離洗脫液中的元素濃度） 

 

3.5.淬息曲線及最小可測量活度 

利用淬息劑及鎳-63標準射源進行消光曲線之製作如圖 5所示，其顯示鎳-63的 LSC的偵測效率可

從 45-73%左右。利用MDA公式計算液態閃爍計數儀分析此系統之鎳-63的最小可測量活度，其MDA

可得 0.0311 Bq/L（如下式所列）。其中鎳-63的 LSC偵測效率在 0.732、系統的化學回收率為 0.886、處

理的水試樣體積為 1公升、LSC計測的時間為 7小時。雖然於一公升的水海試樣中無法測得極微量的

鎳-63，但顯示此方法可得的鎳-63分析之最小可測量活度可達文獻上 LSC可接受之水平低限值。 

 

MDA (LSC) =
4.65 ×  √B +  3

60 ×  E ×  R ×  V ×  T
=  

4.65 × √28.08 × 420 + 3

60 × 0.732 × 0.886 × 1 × 420
= 0.0311 Bq/L 

 

 

圖 5：液態閃爍計數儀之鎳-63淬息曲線建立。 

 

3.6. 綜合討論 

3.6.1. Ni-DMG鎳-63分離方法與鎳-樹脂分離法之比較探討 
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國內外現行鎳-63之分析常見方法為鎳-樹脂法，如圖，本研究開發以 Ni-DMG 沉澱法進行水試樣

中的鎳-63進行分離及計測。其主要優點在於 DMG方法成本較低及操作方便。在回收率比較方面，與

過去文獻相較，Ni-DMG 方法亦可達到接近 90%的穩定化學回收率。尤其，此研究探究以海水為基質

進行鎳的分離，建立可達一定程度的化學分離回收穩定性，代表此法除了核電廠除役廢水中的應用外，

亦可能適用於環境中微量鎳-63的分析偵測可能。 

 

 

圖 6：以 Ni-DMG樹脂進行鎳-63化學分離示意圖。 

 

3.6.2. 在海水基質中鎳-63化學分離之影響 

此研究中，利用 Ni-DMG 在海水基質中進行鎳-63 的分離程序建立。發現效率無法突破 95%甚至

更高的可能原因，是本研究中在進行 Ni-DMG錯合反應前，並未先將海水中的大量鹽分基質給移除。

未來，在這錯合之前，可先加氫氧化鐵（Fe(OH)3）作為吸附劑，其高的表面吸附能力可在適能的 pH

環境當中將海水基質如磷酸鹽的部分反應，形成共沉以達到先移除，讓後續的鎳-63分離時較不受鹽類

及其它金屬元素影響。此步驟預計將可再提升化學回收率到大於 95%以上，並增加其實驗再現度及量

測準確度可能。 

 

3.6.3. 淬息曲線、試樣活度分析及最小可測量活度 

此分析方法之淬息曲線建立，可利用消光曲線進行試樣中受干擾試樣之活度回推，減少試樣中因

淬息造成的活度分析影響。然而，本研究中，亦使用新穎之 TDCR LSC技術進行分析，其原理利用三

根光電倍增管進行計測，原理上所得之 TDCR值可視為偵測效率，可減少分析時之準備時間。然因為

此分析試樣為環境試樣，因為幾乎無法量測到鎳-63的射源活度，必須仍然以添加的標準鎳-63射源作

為標及回收率監測等。在新的 TDCR LSC 其最小可偵測活度計算，以一公升的海水作分析，可得其

MDA 在~0.6 Bq/L，此值有意義的低以符合環境監測的需要，並可考慮作為例行性監測分析方法的參

考。 

 

4. 結論 



16 
 

本研究完成 Ni-DMG沉澱法進行鎳-63分析技術開發。研究中利用 1公升海水作為基質進行分析，

雖然未得檢出海水中的鎳-63含量（因為極微量），但建立穩定的鎳-63化學分離方式可達化學回收率在

接近 90%。LSC的最小可偵測活度在 0.03 Bq/L，可達到文獻 LSC分析鎳-63之水平。未來，此系統預

期可作為在環境或低放射性廢棄物試樣或環境水試樣中進行應用，並提供未來精進鎳-63分離及分析之

參考與基礎。 
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